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FIELDBUS PLUG

Profibus

PROFIBUS is an open serial communication standard that enables data exchange between all
kinds of automation components. In PROFIBUS communication, the master station — usually
a programmable logic controller (PLC) polls the nodes which respond and take the actions
requested by the master. It is also possible to send a command to several nodes at the same
broadcast and in this case the nodes do not send a response message to the master. The
physical transmission medium of the bus is a twisted pair cable (according to the RS-485
standard). Up to 32 nodes can be connected to the same PROFIBUS network segment with-
out the use of repeaters. With repeaters, it is possible to connect 126 nodes (including re-
peaters and a master station) to the network. To configure a Profibus master, the configura-
tion tool needs a GSD file for each type of slave on the network. The GSD file is a Profibus DP
standard text file containing the necessary communications set-up data for a slave.

The Profibus protocol is a fieldbus protocol that provides full control and status information
of the softstarter, reading as well as writing of parameters. Through the fieldbus it is possi-
ble to start and stop the motor, read out currents and frequency, get information about pro-
tections, warnings, faults and much more.

See chapter 8 in the Installation and commissioning manual, document 1SFC132081M0201,
for fieldbus related settings.

Before the Profibus DP fieldbus can be taken in operation following parameters must be set
in the softstarter:
— Parameter 12.2 FB interface connector set to FbPlug.

— Parameter 12.3 Fieldbus control set to On Fieldbus control set to On (if using fieldbus only
to monitor this parameter can be set to Off).

— Parameter 12.4 Fieldbus address set to desired Profibus station address.

] Information

| I}| After changing any of the communication parameters it is needed to perform a
power cycle of the device for the parameter values to be taken into effect. Or an-

other way for a communication parameter value change to be taken into effect is

to set parameter 12.2 FB interface connector to “None” and then set it back to

“FbPlug”.

For technical data and descriptions of the Profibus DP fieldbus plug, see docu-
ment 2CDC192001D0208, available at

To do the programming of the PLC, following GSD files are available:

GSD file

Type of protocol

ABB_078F.gsd
ABB_082d.gsd

Profibus DP VO
Profibus DP V1

STATUS SECURITY LEVEL
Approved Public
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Information
| The GSD file contains information about different software versions of the
softstarter.

Check that correct part of the file is used in relation to the actual softstarter ver-
sion.

If there is no message passed between the PSTX softstarter and the Fieldbus
plug for more than 100ms, the PSTX softstarter will trip on fieldbus communica-
tion failure protection (P1EOO) and with the default configuration, the motor will
be stopped. If the fieldbus communication system is setup in such a way that
commands/requests are not continuously passed between the PLC and
softstarter, this protection function should be disabled. The parameter 19.4
(Fieldbus failure op) can then be set to “Off”.

Caution!
The motor may start unexpectedly if there is a start signal present when doing
any of the actions listed below.

— Switching from one type of control to another (fieldbus control/hardwire
control)

— Reset all Settings

1.1. Digital input telegram

To PLC from softstarter.

Word in input Digital in- Bit Data Description

data area put byte

0] 0 0] Auto Mode status® 0 = Softstarter control through
fieldbus communication not al-
lowed

1 = Softstarter control through
fieldbus communication allowed

1 Event status 0 = No active fault/warning/pro-
tection
1 = Active fault/warning/protec-
tion

2 Ready To Start 0 = A start will probably cause a
fault
1= A start will not cause a fault

3 FBT Response O See section 2 Fieldbus Tasks
4 FBT Response 1 See section 2 Fieldbus Tasks
5 FBT Toggle Bit See section 2 Fieldbus Tasks
6 Programmable Function of programmable digital
Digital Input 1 input, see section 1.2
STATUS SECURITY LEVEL DOCUMENT ID. REV. LANG. PAGE
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1 8(0)

9(1)

Programmable
Digital Input 2

Programmable
Digital Input 3

Programmable
Digital Input 4

10 (2) Programmable

Digital Input 5

11(3) Programmable

Digital Input 6

12 (4) Programmable

Digital Input 7

13(5) Programmable

Digital Input 8

14 (6) Programmable

Digital Input 9

15(7) Programmable

Digital Input 10

) Auto mode reflects the control state of the Softstarter. This is affected by a combination of:

— The Auto mode input signal from the PLC (Digital output telegram).

— The state of the Local/Remote switch on the HMI.

— The parameter “Fieldbus control”.

— The digital input “Fieldbus disable”.

1.2. Programmable Digital Inputs

The functions of the programmable Digital inputs are controlled by the parameters Fieldbus

DI 1 through Fieldbus DI 10. The following functions are available for selection:

Function Data

None Value is set to O
Start feedback Status of Start signal
Stop feedback Status of Stop signal

Fault reset feedback

Slow speed reverse feedback
Slow speed forward feedback
Start 1 feedback

Start 2 feedback

Start 3 feedback

Motor heating feedback

User defined feedback

Status of Reset signal

Status of Slow speed reverse signal
Status of Slow speed forward signal
Status of Start 1 signal

Status of Start 2 signal

Status of Start 3 signal

Status Motor heating signal

Status of User defined protection signal

STATUS SECURITY LEVEL
Approved Public
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FIELDBUS PLUG

Function

Data

Stand still brake feedback
Emergency mode feedback
Start reverse feedback

Run status

TOR status

Line

Phase sequence

Event group O status
Event group 1 status
Event group 2 status
Event group 3 status
Event group 4 status
Event group 5 status
Event group 6 status
Sequence 1 Run status
Sequence 2 Run status
Sequence 3 Run status
Sequence 1 TOR status
Sequence 2 TOR status
Sequence 3 TOR status

Run reverse status

Enable status

Digital InO status

Digital Inl status

Digital In2 status

Local control status

Cancel brake feedback

Pump cleaning auto status
Pump cleaning forward status

Pump cleaning backward sta-
tus

External digital 1DIO status
External digital 1DI1 status
External digital 1DI2 status
External digital 1DI3 status
External digital 1D14 status
External digital 2DI5 status
External digital 2DI16 status

Status of Stand still brake signal
Status of Emergency mode signal
Status of Start reverse signal

1 = Indicates when the softstarter gives voltage to the
motor

Top of Ramp. 1 = Indicates that motor runs on full voltage
Line or Inside Delta Connection; O = Line, 1 = Delta
0=1L1L2,L3;1=11,L3,L2

0 = No active events present in group O.

0 = No active events present in group 1

0 = No active events present in group 2

0 = No active events present in group 3

0 = No active events present in group 4

0 = No active events present in group 5

0 = No active events present in group 6

Run status of sequence connected motor 1

Run status of sequence connected motor 2

Run status of sequence connected motor 3

Top of Ramp status of sequence connected motor 1
Top of Ramp status of sequence connected motor 2
Top of Ramp status of sequence connected motor 3

1 =Indicates when the softstarter gives voltage to the
motor after a reverse start

Status of Enable signal

Status of internal digital input InO

Status of internal digital input In1

Status of internal digital input In2

0 = Remote control, 1 = Local control (HMI)
Status of Cancel brake signal

Status of automatic pump cleaning
Status of forward pump cleaning

Status of reverse pump cleaning

Status of external digital input 1DIO
Status of external digital input 1DI1
Status of external digital input 1DI2
Status of external digital input 1DI3
Status of external digital input 1D14
Status of external digital input 2DI5
Status of external digital input 2DI6
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1.3.

1.4.

FIELDBUS PLUG

Function

Data

External digital 2DI7 status
HW DI Start status
HW DI Stop status

Ready to start (line contactor)

Status of external digital input 2DI7

Status of the hard wire internal digital input Start

Status of the hard wire internal digital input Stop

Same conditions as the Ready To Start bit except that the
incoming three phase voltage condition is excluded. The
bit can be used when a line contactor is connected

Analog input telegram

To PLC from the softstarter.

All analog data is represented as 16-bit values.

A protocol for Fieldbus tasks is used to read and write parameters. It is applicable for all

Data

Representation

Fieldbuses.

Word ininput  Analog in-
data area put word
1 0]

2 1

3 2

4 3

5 4

6 5

7 6

8 7

9 8

10 9

11 10

FBT Return Value

Programmable Analog Input 1
Programmable Analog Input 2
Programmable Analog Input 3
Programmable Analog Input 4
Programmable Analog Input 5
Programmable Analog Input 6
Programmable Analog Input 7
Programmable Analog Input 8

Programmable Analog Input 9

Programmable Analog Input 10

See section 2 Fieldbus
Tasks

Function of programma-
ble analog input, see sec-
tion1.4

Programmable Analog Inputs

The functions of the programmable analog inputs are controlled by the parameters Fieldbus
Al 1 through Fieldbus Al 10. The following functions are available for selection:

Function

Representation

None

Phase L1 current!
Phase L2 current!
Phase L3 current!
Active power (hp)

Active power

Value is set to O

Value = 1000 = 100A
Value = 1000 = 100A
Value = 1000 = 100A
Value =1000 = 10hp
Value = 1000 = 10kW
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Function

Representation

Apparent power
Mains voltage

Power factor

Motor voltage
Active energy (resettable)
EOL time to trip

Mains frequency

Max phase current?

Motor current

Motor run time (resettable)
Motor temperature

Motor temperature percent
Number of starts (resettable)

Phase sequence

PT100 temperature

PTC resistance

Reactive energy (resettable)
Reactive power

Remaining time to start
Thyristor temperature
Thyristor temperature percent
EOL time to cool

Top event code

Motor current in percent of IE.
Thyristor run time (resettable)

Motor connection

Phase L1 current high range?
Phase L2 current high range?

Phase L3 current high range?

Value = 1000 = 10kVA
Value = 1000 = 100V

Value=100=1
Example: 87 = 0.87

Value = 100 = 100%
Value = 1000 = 10kWh

Value =100 = 100s
Value = 65535 = No overload
Value = 0 = Trip already occurred

Value = 1000 = 100Hz
Value = 1000 = 100A
Value = 1000 = 100A
Value =100 = 1000h
Value =100 = 100°C
Value =100 = 100%
Value =1 =100

Value =0 = L1->L2->L3
Value =1= L1->L3->L2
Value = 2 = No sequence detected

Value =n=n/10-50°C
Example: 750 = 25°C

Value =100 = 100Q
Value = 1000 = 10kVArh
Value = 1000 = 100kVAr
Value =100 = 100s
Value =100 = 100°C
Value =100 = 100%
Value =100 = 100s
Value =1000 = 1000
Value =100 = 100%
Value =1 = 10h

Value = 0 = auto

Value =1 = In-line

Value =2 = Inside delta - Ul
Value = 3 = Inside delta - IU
Value = 4 = 2-phase L1 shorted
Value = 5 = 2-phase L2 shorted
Value = 6 = 2-phase L3 shorted

Value = 100 = 100A
Value =100 = 100A
Value =100 = 100A

STATUS SECURITY LEVEL
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Function

Representation

Active power (hp) high range?
Active power high range?
Apparent power high range?
Reactive power high range?
Max phase current high range?
Max motor current high range?
Active energy high range?

Reactive energy high range?

Number of starts (high precision)

Value =100 = 100hp
Value =100 = 100kW
Value = 100 = 100kVA
Value = 100 = 100kVAr
Value =100 = 100A
Value =100 = 100A
Value =1 = 10000kWh
Value =1 = 10000kVArh

Value=1=1

D Phase current L1, L2 and L3 indicate the current through the softstarter, while the Max
phase current is always the line current.

3 High Range alternatives are available for a few signals where there is a possibility for the
values to wrap. The values are 16-bit so the maximum value for each signal is 65535. The High
Range alternatives have different scaling and will never wrap around but instead have lower

precision.

1.5.

From PLC to the softstarter.

Digital output telegram

Word in Digital Bit Data Description
output output
dataarea byte
0] 0] 0] Start Commence a start when signal is set.
1 Stop Commence a stop when signal is negated.
2 Fault reset Reset signal for possible events.
3 Auto mode This must be set for controlling the motor.
4 Slow speed Perform slow speed reverse when signal is
reverse set.
5 Slow speed Perform slow speed when signal is set.
forward
6 Spare
7 Startl Startl if sequence start.
1 8(0) Start2 Start? if sequence start.
9(1) Start3 Start3 if sequence start.
10 (2) Motor heat- Perform motor heating when signal is set.
ing
11 (3) Stand still Perform stand still brake when signal is set.
brake
12 (4) Startreverse Commence a reverse start when signal is
set.
STATUS SECURITY LEVEL DOCUMENT ID. REV. LANG. PAGE
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Word in Digital Bit Data Description
output output
dataarea byte
13(5) Spare
14 (6) Emergency Set to “1” to enable emergency mode.
mode
15(7) FBT Toggle See Fieldbus Tasks.
Bit
1 2 16 (0) Userdefined Set to “1” to trigger user defined protec-
trip tion.
17 (1) Switchtore- Switch to remote control when signal is set
mote control  (rising edge triggered).
18 (2) Pumpclean- Perform automatic pump cleaning when
ing auto- signal is set.
matic
19 (3) Pumpclean-  Perform forward pump cleaning when sig-
ing forward nal is set.
20 (4) Pumpclean- Perform reverse pump cleaning when signal
ing reverse is set.
21(5) K4relaycom- Set “1” to activate the internal K4 output re-
mand lay. Note that parameter 10.4 K4 function
has to be set as “Fieldbus”
22 (6) Kb5relay com- Set “1” to activate the internal K5 output re-
mand lay. Note that parameter 10.5 K5 function
has to be set as “Fieldbus”
23(7) K6relay com- Set “1” to activate the internal K6 output re-
mand lay. Note that parameter 10.6 K6 function
has to be set as “Fieldbus”
3 24 (0) 1DOO relay Set “1” to activate the external 1DOO output
command relay. Note that parameter 11.9 1DOO func-
tion has to be set as “Fieldbus”
25(1) 1DO1relay Set “1” to activate the external 1DO1 output
command relay. Note that parameter 11.10 1DO1 func-
tion has to be set as “Fieldbus”
26 (2) 2DO02 relay Set “1” to activate the external 2DO2 output
command relay. Note that parameter 11.11 2DO2 func-
tion has to be set as “Fieldbus”
27 (3) 2DO3relay Set “1” to activate the external 2DO3 output
command relay. Note that parameter 11.12 2DO3 func-
tion has to be set as “Fieldbus”
28 (4) Spare
29 (5) Spare
30 (6) Spare
31(7) Spare
STATUS SECURITY LEVEL DOCUMENT ID. REV. LANG. PAGE
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1.6. Analog output telegram

From PLC to the softstarter.

All analog data is represented as 16-bit values.

Wordin  Analog Data Representation
output output
data area word

2 0] FBT Control Word This register is used to read parameters (see
fieldbus tasks).
3 1 Fieldbus AO 1 (FBT Parameter 12.37 Fieldbus AO1 decides the use
Argument 2 or Inter-  of this register. If set as "FBT Argument 27, it
nal analog output) is used to write parameters and set time (see

fieldbus tasks). If set as “Internal analog out-
put” this value of this register controls the in-
ternal analog output. Note that parameter
10.8 AO type needs to be set as “Fieldbus

[%]”.
4 2 Fieldbus AO 2 (FBT Parameter 12.38 Fieldbus AO2 decides the use
Argument 3 or Exter-  of this register. If set as "FBT Argument 3", it
nal analog output) is used to write parameters and set time (see

fieldbus tasks). If set as “External analog out-
put” this value of this register controls the ex-
ternal analog output. Note that parameter
11.14 1A0O0 type needs to be set as “Fieldbus
[%]”.

2. Fieldbus Tasks

By using Fieldbus Tasks it is possible to read/write parameters and to set the real-time clock.

Which task to execute is selected by filling in the FBT Control Word. There are three signals
for arguments to the task:

— FBT Argument 1 is packed together with the Task ID in the FBT Control Word.

— There are two additional 16-bit arguments in separate analog output signals, FBT Argu-
ment 2 and FBT Argument 3.

To control when the task is executed, the digital output signal FBT Toggle Bit shall be
changed. The softstarter will detect the change, execute the task, fill in the return values, and
toggle the digital input signal FBT Toggle Bit as acknowledgement. Thus, the return values
must be disregarded if the two toggle bits have different value.

STATUS SECURITY LEVEL DOCUMENT ID. REV. LANG. PAGE
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2.1.

2.2.

2.3.

2.4.

FIELDBUS PLUG

FBT Control Word

The control word is a 16-bit analog output value sent from the PLC to the softstarter. It con-
sists of a Task ID and an 11-bit argument packed together.

15 14,13,12, 11 10,9,8,7,6,5,4,3,2,1,0

- Task ID - Argument 1

Task ID

The task identifier controls which function should be performed.

Task Task Response ID

ID Positive Negative
0] No task 0] -

1 Request parameter value, lower word 2

2 Change parameter value 1 2

3 Set date and time 1 2

4 Request parameter value, upper word 1 2

Response ID

The response ID is the softstarter response to a task. It tells whether a task was executed
successfully. If there was an error, an additional error code is returned in the FBT Return Value
analog input. The Response ID is transmitted as two digital input signals, FBT Response O
and FBT Response 1.

Response ID FBT Responsel FBT Response O Explanation

0] 0 0 No response

1 0] 1 Task executed

2 1 0] Task cannot be executed
(with error number)

3 1 1 Reserved.

Error codes

The following error codes are sent when a task cannot be executed.

Error code Explanation

Illegal parameter number
Parameter value cannot be changed
Lower or upper limit violated

Invalid argument

No error

ol | MW | | O

Invalid task number

STATUS
Approved

SECURITY LEVEL DOCUMENT ID. REV. LANG. PAGE
Public 1SFC132091M0201 E en 12/26

© Copyright 2019 ABB. All rights reserved.




2.5.

2.5.1.

2.5.2.

2.6.

2.6.1.

2.6.2.

2.7.

FIELDBUS PLUG

Request parameter value, lower word

This task reads the lower 16 bits of the specified parameter’s value. See chapter 2.9 for pa-
rameter number and value scaling information.

Arguments

- FBT Argument 1: parameter number.

Return Value
— Response ID 1 and parameter value in FBT Return Value on success.

— Response ID 2 and error number in FBT Return Value on failure.

Change parameter value

This task writes a specified value to a parameter. See chapter 2.9 for parameter number and
value scaling information.

Arguments

— FBT Argument 1: parameter number.

— FBT Argument 2: parameter value (lower word).

— FBT Argument 3: parameter value (upper word).

Return Value
— Response ID 1 on success.

— Response ID 2 and error number in FBT Return Value on failure.

Set date and time

This task updates the real-time clock on the softstarter. The date and time fields have the fol-
lowing limits:

- Year: 0-63 (2000-2063)

— Month: 1-12

- Day:1-31

- Hour:0-23

— Minute:0-59

— Second:0-59
STATUS SECURITY LEVEL DOCUMENT ID. REV. LANG. PAGE
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2.7.1.

2.7.2.

2.8.

2.8.1.

2.8.2.

2.9.

FIELDBUS PLUG

Arguments

FBT Argument 2: year, month, day and least significant bit of seconds

15 14,13,12,11,10,9 8,7,6,5 4,3,2,1,0

sO year month day

FBT Argument 3: hour, minute, seconds, bit 1-5

15,14,13,12,11 10,9,8,7,6,5 4,3,2,1,0

Hour minute seconds, bit 1-5

Return Value
— Response ID 1 on success.

— Response ID 2 and error number in FBT Return Value on failure. In case the supplied time
didn’t differ from the set time, error code 5 (no error) is used.

Request parameter value, upper word

This task reads the upper 16 bits of the specified parameter’s value. See chapter 2.9 for pa-
rameter number and value scaling information.

Arguments

— FBT Argument 1: parameter number.

Return Value
— Response ID 1 and parameter value in FBT Return Value on success.

— Response ID 2 and error number in FBT Return Value on failure.

Parameter numbers and values

To access parameters from the fieldbus a unique parameter number is needed, this can be
found in document 1SFC132081M0201, Chapter 7.25 Complete parameter list. Since the pa-
rameter values need to be represented as integers on the fieldbus, the parameter values with
greater precision need to be scaled. In document 1SFC132081M0201, Chapter 7.25 Complete
parameter list, there is a column specifying the number of decimals for each parameter.

Parameter values that are read from the fieldbus needs to be divided by 10Qnumbers of decimals

Parameter values that are written from the fieldbus needs to be multiplied by 1Qnumbers of deci-

mals

STATUS
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For example:
The parameter Kick start time has parameter number 24 and 2 decimals. To read this param-
eter:

=

Set FBT Task ID to 1.

2. Set FBT Argument 1 to 24 to specify the parameter.

3. Toggle FBT Toggle Bit output and wait for the FBT Toggle Bit input to update.
4. Response ID 1 should now contain value 1, indicating success.
5

. FBT Return Value contains the value 50 (this is an example and depends on the actual
value set).

6. The return value should be interpreted as 50/102 = 0.5s.

To change the Kick start time parameter to 1s:
1. Set FBT Task ID to 2 for Change parameter value.

2. Set FBT Argument 1 to 24 to specify the parameter.
3. Set FBT Argument 2 to 1*102 = 100.

4. Set FBT Argument 3 to 0 as 100 <= 65535 which means it doesn’t require more than 16
bits.

4

Toggle FBT Toggle Bit output and wait for the FBT Toggle Bit input to update.

)}

. Response ID 1 should now contain value 1, indicating success.

2.9.1. Negative values
Negative values are represented internally using 32-bit two's complement numbers.

Example:
Setting parameter 17.5 PT100 reset temp (parameter number 249) to a value of -25°C:

The two’s complement of -25 is FFFFFFE7hex. The upper word is FFFFhex and the lower FFE7hex,
in decimal notation 65535 and 65511.

1. Set FBT Task ID to 2 for Change parameter value.
. Set FBT Argument 1 to 249 to specify the parameter.
. Set FBT Argument 2 to 65511 to specify the lower word.

2

3

4. Set FBT Argument 3 to 65535 to specify the upper word.

5. Toggle FBT Toggle Bit output and wait for the FBT Toggle Bit input to update.
6

. Response ID 1 should now contain value 1, indicating success.
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3.1.

FIELDBUS PLUG

Configure ABB Automation Builder

This part of the document describes how to configure an ABB AC500 PLC using the CM592-
DP module to control a PSTX Softstarter with an FBP Profibus module.

Create a new project

1. Open Automation Builder.

2. Select File->New Project->AC500 project->OK.

3. Select the correct PLC CPU in Search object name ...-> Add PLC.

Categories S
7- PLC - AC500 V2 Name
- PLC - ACS00 V3 07KT98-ARC-AD

07KT98-ARC-DP-AD
07KT98-ARC-ETH-AD
07KT98-ARC-ETH-DP-AD
07KT98-ETH-DP-AD
£ AC500 PM554

1 AC500 PM554-ETH
1 AC500 PM5SE-ETH
1 AC500 PM5EL

1 AC500 PM5B4-ETH
] AC500 PM5EE-ETH
AC500 PM572

T AC500 PM573-ETH
£

Short Description S

07KTS8-ARCNET adapter ¢
07KTS8-ARCNET-DP adap
07KT38-ETH-ARCNET adz
07KT38-ARCNET-ETH-DP
07KTS8-ETH-DP adapter s:
8DI/6DO-T, 24VDC or 115
8DI/6D0-T, 24VDC, Ethemr
8DI/6DO-T, 24VDC, Bthem
6DI/6DO-TA2A11AQ, 24VI
6DI/6DO-TA2AI1AQ, 24VI
6DI/6DO-TA2AI1AD, 24VI
ACB00CPU 128kB

AC500CPU 512kB, Ethemi v
>

Clese this dialeg after each transac Display all versions

Close

4. Check that the correct device type is selected by double clicking the device name in De-
vices field. Check that the correct Terminal Base Type is also selected for the tag for Hard-

ware.

Devices > o X
=5 pstr h
" PLC_PSTX (PM573-ETH - TB521-ETH)
= @1] pstx_control
F App
10_Bus
-z Interfaces
t COM1_Online_Access {COM1 - Online Access)
m COM2_Online_Access {COM2 - Online Access)
ﬁ FBP_Online_Access (FBP - Online Access)
= a Ethernet
@l emiEmy
@ Protocols {Protocols)
= ﬂ Extension_Bus
B Slot_1(Tas24)
B siot_2(Tas2q)

PLC_PSTX X
PM573-ETH Parameters
PM573-ETH Hardware

Information

PLC AC500 V2
PM5xx Type: PM573-ETH l
Terminal Base Type: TB521-ETH pd

Change PM [ TB type

[] Change to ACS00 W3 PLC
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FIELDBUS PLUG

5. Optional: rename the project and the Application to some more suitable names for exam-
ple “pstx” and “pstx_control”

| {PM573-ETH - TB521-ETH)
= @1] psti_control

App
10_Bus
Interfaces

3.2. Install the Profibus GSD-file

1. In the Tools menu select Device Repository

File Edt View Project Onine Debug | Tools | Window Help
@ EBEEHI&E | dh -A:a | D’= | Installation Manager
Create Device list 5V
Instal additonal license
= TXFE_L1 |3 Profibus_Master {47 PoP22FEP VI Tj PLC_PSTX X[ CMS92_DP
Ip-Configuration
pstx
PLC ACS00 V2
- [T [PLC_PSTX (PMS73ETH -TBS2LETH) MultOriineChange [T Parameters
= B pstx_contral Drive Overview L ardware M Types P —— »
© app Install application
= 10.8us Terminal Base Type: | TBS21-ETH -
- [ Device Repository... ion
= g Interfaces ;
B3 com1_online_Access (oM Migrate third party devices Change PM /7B type
B com2_online_Access (COM Open Device Type Editor -
B2 Fep_online_access (Fep O Device ECAD data
= &% ethernet
@ emiEmy W License Manager... [] change to AC500 V3 PLC
#l Protocols (Protocols) | ¥ Wsudlization Styles Repositary...
+ il Extension_Bus Seripting 3
Options...

2. Click Install

€ Device Reposi =X

Location: [ System Repostory - [ Edit Locations... ]
(C:\ProgramData\AutomationBuider|AB_Devices_2.1)

Installed deyice descriptions:

String for a fultext search Vendor: [ <Al vendors>
Name Vendor Version
8411939 =
* 19 Modbus =
= profibus M
#- 1 DP Device
T R i Renew device
= DP Save
[ 35 P DP-Save 35 - Smart Software Solutions GmbH ~ 35-PBSkve.gsd - Version 1.000 (HW=Versc
i) ABB Drives FPBA-01 DP-VO  ABB Oy 2.7.00
7)) ABB Drives FPBA-01 DP-V1  ABB Oy 2.7.00
7)) ABB Drives RPBA-01 DPVO  ABB Oy 2.7.00
U3 ABB Drives RPBA-01DPV1  ABB Oy 2.7.00
8 Acgs10 PROFIBUS ABB Oy 2.7.0.0 Details
) acs3s5 PROFIBUS ABB Oy 2.7.0.0
2 acs380 PROFIBUS ABB OY 2.7.0.0 <
<« il ] 3
Close
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3. Select and install the EDS-file: ABB_082D.gsd

¥ Device Rep

FIELDBUS PLUG

Location:

[System Reposttory

v | EditLoations..

(C:\ProgramData'\AutomationBuilder\AB_Devices_2.1)

Installed device descriptions:

+ 5 sercos

<

101 |

String for a fulltext search Vendor: <Al vendors> vl Install...
Name Vendor Version - Uninstall
l-:[] C1542-DP ABB Automation Products GmbH 2.7.0.0 —
[a CM582-DP ABB Automation Products GmbH 2.7.0.0
Ul cMs82-DP-Slave ABB Automation Products GmbH 2.7.0.0
Bl oP22-FBP (V1) ABB ABB_082D.gsd - V 2.07 (HW=V 1.0 SW=V 1.0)
Ul poP22-FBP CPU Slave ABB Automation Products GmbH 2.7.0.0
i-:’] PDP22-FBP DC505 ABB Automation Products GmbH 2.7.0.0

= € C:\plc\Automation Buider\ABB_082D.gsd
& Device "PDP22-FBP (V1)" installed to device repository.

Close

3.3.
PSTXS

lave

Add the CM592-DP PROFIBUS master module and the

1. Right click on the empty slot where the CM592-DP module is installed and select “Add ob-

ject”.

Select the Profibus master module, here we select “CM592-DP”, in the Replace object win-
dow. Click “Replace object” to close the Replace object window.

Devices.

> 1 X

= e

= £l pstx_contral
© Ao
& 1080
e Interfaces
B comi_on
B2 comz_o

=-E2 Ethernet

@ Protoc
=@ Extension_Bus

= (& PLC_PSTX (PMS73ETH - TB521-ETH)

niine_Access (COM1 - Online Access)
niine_Access (COM2 - Online Access)

B41 FEP_Online_Access (FEP - Online Access)

4 emiEmn

ols (Protocols)

B sht2(

B [slot_t (rasaa

Copy
Paste

& cut

¥ Delete

Rename

Add object

Update objects
=) Add Folder..
[T Edit Object

Replace object: Slot_1

Object path:
PLC_PSTX\Extension_Bus\Slot_1

Objectname:  [CM592_DP

Categories ~ | |cm

—

5]
5]
5]
5]
5]
5]
5]
5]
5]
5]
5]

<

Name

gl cms720P
7l cMs74RCOM

7l cMsasCAN

Short Description

PROFIBUS DP VO/V1 master module
Medule for RCOM/RCOM+ protocol

Free configurable serial interface module
Ethemet module {TCP/IP, UDP/IP, Modbus
CAN/CANopen master module

EtherCAT Module

EtherCAT Module

PROFINET 10 controller module
PROFIBUS-DP Slave module

CANopen slave module

PROFINET 10 device module

PROFINET 10 device module

PROFIBUS DP VO/V1 master module
Ethemet module {TCP/IP, UDP/IP, Modbus
CAN/CANopen master module W

>

Close this dizlog after each transaction Display all versions

Compare Objects Reset filter Replace abject Close
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FIELDBUS PLUG

4. Right click on the newly installed Profibus_Master and select “Add object”.

Devices * 0 X
= pstx hd
= PLC_PSTX (PM573-ETH - TB521-ETH)
= @l] pstx_control
£ app
10_Bus
=g Interfaces
m COM1_Online_Access (COM1 - Online Access)
m COM2_Online_Access {COM2 - Online Access)
m FBP_Online_Access (FBP - Online Access)
= a Ethernet
8 emiEmy
@ Protocols (Protocols)
= g Extension_Bus
=B cMs92_DP (CM532-0F)
Eﬂmnnnrm'myﬁh. Mactarl J
B st 2(a Copy

Paste

4 cut

¥ Delete

m

Rename

[ addobject
Update objects

=) Add Folder...
[] EditObject
Compare Objects

Check configuration

5. Select PDP22-FBP (V1) found under Uncategorized and click “Add object”.

Add object below : Profibus_Master x

Object path:
PLC_PSTX\Extension_Bus\CM552_DP\Profibus_Master

Objectname:  |PDP22_FBP_V1

Categories w |'3-sa|'-:h object name... 8,
Communication interface modules Mame Short Description ~
[E;:ﬂen;unicaﬂon modules !ﬂ]ACSSE»D PROFIBLS
Fieldbus Plug ¥lAcsas0 PROFIBUS
Seripting Bf) ACS880 PROFIBUS
Uncategorized Yl Acs2a0-M04 PROFIBUS

¥lACSM1 Motion PROFIBUS
YHlACsM1 Speed PROFIBUS
Bl Anybus-5 DRV (FW 3.0

!@CIH‘I—DP BDI/BDO/4A1/2A0 PROFIBUS T
wCIMZ—DP 8DI1/8D0/BDC PROFIBUS DP S
!@CMB&Z—D P-Slave PROFIBUS Slave device module
YPDP22-FBP CPU Slave PROFIBUS Fieldbus Plug, CPU £
!@PDPZZ—FBP DC505 PROFIBUS Fieldbus Flug, DC50¢
ElpsTx

L[ Script v
< >

Close this dizlog after each transaction Display all versions

Reset filter Add object Close
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FIELDBUS PLUG

6. The PD22_FBP_V1is now added. Change the Station Address to match the value set to
Fieldbus address (Parameter 12.4) in the PSTX.

Devices -1 X [T PePsTx o9 CMs32.DP # Profibus_Master Il poP22_FBP V1 X

=5 estr
= [T PLC_PSTx (PM573-ETH - TBS21-ETH)
=80 pstx_conral

B com2_Online_Access (COM2 - Orline Access)
B Fop_Online_Access (FEP - Online Access)
= &4 Ethernet
A emiEm)
@ Protocols (Protocols)
=@ extension_bus
= B3 cms92_DP (cMs92-DP)
= B Profibus_Master (Profibus-Master)
Ui pop22_FBP_v1 (POP22-FBP (V1))
B siot_2(TA529)

7. Right click on the newly installed PDP22_FBP and select “Add object”

| General

| 1/0 mapping list

e Parameter

StationAddress: =

o)
& App 1dent Number: [0x082D Lockjunlock: | 2 Lock) Time (ms): 400[2
@ 10.8us Groups..
Check configuration
T @ Interfaces User parameters
B coM1_Online_ccess (COM1 -Online Access) TR Defoults

Symbolic Values

T_SDR {tBit): 1 2

Length of user parameters (Byte): §

Watchdog
Watchdog Control

AeeFn

Parameter
Block-Parameter
Diagnosis Format.

Value Allowed values
Use Block-Parameters Unsigneds 0 0-1
DPVO Diagnoss Format  Unsigneds 0 0-1

Devices ~ 3 X {7 Pcpstx § CM532_DP 2y Profbus_Master Y3) pop22_FBP_V1 X
ERr— S
=[] PLC_PSTX (PM573-ETH - TES2L-ETH) Ga=cl PDP22-FBP (V1)
@ D:.fx’wnm 1f0 mapping list ~
5# App General Information
@08 Check eonfiguration Vendor: ABB
=g Interfaces s 33
B3 com1_oniine_access (COM1 - Gnine Access) Information o 0820 POP22FEP (V1)
B2 COM2_Oniine_access (COM2 - Onlne Access) Version ABB_0BID.gsd -V 2.07 (HW=V 1.0 SW=V 1.0}
?H: FBP_Onine_Access (FEP - Oniine Access) Description: Profibus DP Slave imported from ABB_0820.gsd
=gty Ethernet
@ emiEmHy Categories
@ Protocols (Protocals) Uncategorized
=@ Extension_Bus
=B cMs32_DP (CMS32DP)
=B Profibus_Master (Profibus-Master)
¥l[poP2z2 ¥
M st 2(Tas2q) s::; E
4 cut
¥ Delete
Rename
‘Add object
Update objects
2 Add Folder...
[§" EdtObject
Compare Objects
Check configuration
8. Select PSTX and click “Add object”.
|Categories V||3ec-. ch object name L
Elc”mi“g . Name Short Description  Version ™
at i
reaegans i PST (CU 05.03.09) ABB_0%:
@ PST(CU 05.04.04) ABB_D8:
[ PST(CU 05.05.00) ABB_D8:
@ PST(CU 06.00.00) ABB_D8:
PSTX(FB 1.1) ABB_D8:
L [ Script
[i] Sensopart ABB_08:
(ill Sensor (static mode) ABB_08:
[l ss91-FBP ABB_{8:
il urD10 ABB_08:
il uFD104 ABB_08:
il uFD20 ABB_08:
(il uFD20A ABB_08:
@ UMCZ22-FBP (V3.0) ABB_D8:
[l UMC22-FBP (v3.10, V3.20) ABB_D8: v
£ >
Close this dialog after each transaction Display all versions
Reset filter Add object Close
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FIELDBUS PLUG

9. Map the signals to variable names in DP-Module 1/0 Mapping for the object PSTX_FB_1_1

[l PSTX_FB_1_1 x -
General Find Filter Show all T
DP-Module /O Mapping Variable Mapping Channel  Address Type Unit  Description
/O mapping list 7 Inputo #lB4.0
+- % digital_input_1 ® Byte0 %IB4.0 BYTE
Information -t digital_input_2 # Bytel %IB4.1 BYTE
=% Inputl %6TW4.1
+-% analog_input_1 ® Wordo %IW4.1 WORD
+- % analog_input_2 2 Wordl RIW4.2 WORD
+* analog_input_3 # Word2 %IW4.3 WORD
+-* analog_input_4 P Word3 %IW4.4 WORD
+- % analog_input_5 # Word4 %IW4.5 WORD
+- % analog_input_6 2 Word5 %IW4.6 WORD
+ % analog_input_7 # Worde %IW4.7 WORD
+-* analog_input_8 P Word7 %IW4.8 WORD
+- % analog_input_9 # Words %IW4.9 WORD
+-* analog_input_10 # Word9 %IW4.10 WORD
+* analog_input_11 ® Word10 %IW4.11  WORD
=" Outputd %QB4.0
+-"# digital_output_1 # Byte0 %QB4.0 BYTE
+-"% digital_output_2 ® Bytel %QB4.1 BYTE
+ "% digtal_output_3 o Byte2 %QB4.2 BYTE
w " digital_output_4 ® Byte3 %QB4.3 BYTE
=" Outputl QW42
+-"% analog_output_1 @ Word0 %QW4.2  WORD
+-"# analog_output_2 ® Wordl %QW4.3 WORD
+-"# analog_output_3 o Word2 %QW4.4  WORD
Reset mapping Always update variables: IUse parent device setting - I
% = Create new variable "% = Map to existing variable
Last buid: © 0 ® 0 Precompie: +* Current user: (nobody) @

3.4. Write a simple PLC program to control the softstarter

We perform the following steps for building our start-stop demo program in CoDeSys.

1. Open CoDeSys by double clicking your application in Devices file in Automation Builder, if
itis not opened yet.

=5 pse
= PLC_PSTX (PM573-ETH - TB521-ETH)

= @ﬂlpstx_mntrol

£k App
10_Bus

= Interfaces
m COM1_Online_Access (COM1 - Online Access)
m COM2Z_Online_Access (COM2 - Online Access)
m FBP_Online_Access (FBP - Online Access)

ETH

=gy Ethernet

2. Open program window by double clicking the default program in POUs in CoDeSys.

b

File Edit Project Irsert Ixtras Online Window Help

B E|©)] eS| % [
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FIELDBUS PLUG

3. We choose to use LD as the language of the POU here by right click POUs -> Add Object...
->Insert Name of the new POU -> Choose “LD” for “Language of the POU” -> OK.

MNew POU x
" CoDeSys - Application. ACS00PRO Marme of the new POL: |dem0 -DK
File Edit Project Inset Extras Online Window Help Type of POU Language of the POU Cancel
B B|8]edas $lea| %e@RSH [ & Fogan CL
= I | " Function Black & LD
. : " Function £ FBD
------ [# PLC_PRG [PRG) Add Object...
. Return Type: " 5FC
Rename Object... BOOL 5T
Edit Object " CFC
Copy Object

Delete Object

4. Select the first network, create a contact “START” (by CTRL+K and putting name at “???”)
and two coils “digital_output_1.0” and “digital_output_1.1" (by CTRL+L) in first network.
We let data types as default by clicking OK directly in Declare Variable window. We set dig-
ital_output_1 bit 0 and 1 because we want to set TRUE for “Start” and “Stop”, according to
Section 1.5. The name digital_output_1 comes from end of Section 3.3 (map signals to var-
iable names).

%, demo (PRG-LD) =N e
0001|PROGRAM demo

0002VAR

0003 START:BOOL;

0 OUQEN D_VAR

<« [m 3

START digital_output_1.0

{3}
L

digital_output_1.1

{3}
v/

< [m b

5. Create a second network by CTRL+T

6. Select the second network, add a coil for automode “digital_output_1.3" (by CTRL+L).

S

START digital_output_1.0
{
L

digital_output_1.1

F
............. " }
0002
digital_output_1.2
F
v/
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7. Now we want to create one control button for signing the value of “START” from the first

network into TRUE. We do this by Visualization -> right click -> Add object -> Write name

of the new Visualization as “view” -> OK.

File Edit Project Insert Extras Online Window

He

Wew Visualization

H Sl

2o BlS (25| *E| &Rl

PDUSI": Data t_l,lpes]\r"isualizat... |% Hesourcesl

(1] 4
8. We draw a shape as the button

Regular Element Configuration (#0)

Category:
Bitrmap Input
Teut ¥ Toogle variable
Teut variables
Colorvariables I Tap varable
arniables
-
Text far toalkip
Security [ Zoom to wis:

Programmability

Xy
]

Marme of the new Visualization: |Vi8“*

Cancel

EA
=1

-> double click the shape -> Regular Element Config-
uration -> Input -> check Toggle variable -> insert “demo.START” ->OK.

demo.5TART|

I Execute program: J

I Test input of vanable 'Textdisplay’

|Te:-:t J Mir: |

u [LETS

Dialog title: |

Cancel
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FIELDBUS PLUG

9. We configure this program into task configuration by Resource -> Task configuration ->
Right click Task configuration -> Append Task -> Insert t#10ms in Properties in Taskattrib-
utes. Then we need to sign our program to this task by right click NewTask-> Append Pro-
gram Call-> Choose demo(PRG) by clicking the select button in Program Call ->OK.

B CoDeSys - Application.AC500PRO

ile Edit Project Insert Extras  Online  Window

Help

8| Bl@ledals(2ds Bl

2, Resources

B3 Global Yariables

i Global_Variables
Wariable_Configuration [WaR_CONFIG)

Bl (] fibrar Ethemet_ACS00_v10.6ib 25.6.18 18:33:14: glol
B2 fibrary lecste b 2.6 14 10:37:48: global variables
Bl fibrary Sysint_ACS00_Y100b 25.6.18 18:33:14: globa
B2 ety SysLiblritLibrary b 25 518 16:3314: global va
B2 library SysLibMem.lib 25.6.18 18:3214: global variabl
Bl (2] fibrary SpsLibTime. b 25.5.18 18:33:14: global varisbl
B2 fibrary SysT askinfolib 256,18 18:3314: global variab
B[] library UtiLiB 19.11.14 15:20:48: global variables
B (5] Todls
Alam configuration
m Librar b anager
Ef Log
PLC - Browser
PLLC Canfiguration
1 Samping Trace

ﬁ Target Settings

@, Watch- and Recipe Manager
-~ \workspace

uration

B

< >

POUS| ™1 Data types] ol Visualizal._| §2 Rssouces|

% | Task configuration

El-- (# Task configuration A
L g System events
b (13 NewTask

Taskattrbutes I
Name: [MewT sk
Priciity(0..31] [10
Type
* cyclic

" freewheeling
" triggered by gvent
" triggered by extemal event

[alin] ms

Properties
Interval (e.g. tH200ms):

‘Watchdag
[ Activate watchdog

Timele.a. tH200ms):

Sensitivity:

Check task guration

Attention: Unused 1/0s will not be updated (see target settings)!
of POU "demo

of task ‘MainTask

onfiguration

ofu d
ize: 8182 bytes

10. Right click on the NewTask and select Append Program Call.

5 | Task configuration

B4 Task configuration
g Taskattrbutes
£ System events
Insert Task
Append Program Call
Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V eelin
Delete Del ed by
Set Debug Task ed by
Enable / disable task L.
Interval [e.g
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FIELDBUS PLUG

11. Select the demo program call.

|

B ask configuration -
mT Program Call |
4 System events @
B (Fy NewTask
H @ demol). Program Call: IdEmDO: I
-
« [m] b d

Build and run the PLC demo program

Use the key, F11, to build the program once. Login and start project from Automation Builder
by clicking Alt+F8 to login the CodeSys. Click yes to login.

0 Login

The program has changed! Do you want to load the changes?
[OMLINE_CHANGE)

| Yes || Mo | | Cancel |

Click F5 to start. Switch to CoDeSys and click Alt+F8 to login demo. The program can be con-
trolled with the view from CodeSys.

% demo (PRG-LD) (sElf=]
START = JIRUE
START digital_output_1.0
—inl ®
digital_output_1.1

_(.)—

digital_output_1.3
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4. Contact us

For more information, please contact
your local ABB representative or visit
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